Trainer Clipart v1500
User Manual

Over 1500 High Quality Cutting Edge
Strength and Conditioning Images

www.TrainerClipart.com



http://www.pssathletics.com/store/product.php?productid=1&partner=fitpro

Trainer Clipart v1500

Copyright © 2007

Progressive Sporting Systems, All Right Reserved
Website:| http://www.TrainerClipart.Co
ttp://www.PssAthletics.co

Warning: This product is protected by copyright law and international treaties.
Unauthorized reproduction or distribution of this product or any portion of it may
result in severe civil and criminal penalties, and will be prosecuted to the
maximum extent possible under the law.

For more great coaching tools visit &ww.PssAthIetics.cogl and check out our
constantly growing library of cutting edge training products. And don't forget to
sign-up for our free newsletter full of high powered training tips.



http://www.pssathletics.com/store/product.php?productid=1&partner=fitpro
http://www.pssathletics.com/store/product.php?productid=1&partner=fitpro
http://www.pssathletics.com/store/product.php?productid=1&partner=fitpro

TRAINER CLIPART V1500

END USER LICENSE AGREEMENT

A. IMPORTANT - READ CAREFULLY:

This End-User License Agreement is a legal agreement between you hereby referred to as the Licensee,
and Progressive Sporting Systems Inc. hereby referred to as Licensee for the product Trainer Clipart
hereby referred to as the software. The software product includes computer software, the medias
belonging to it, printed materials and electronic documentation. With installing, copying or any other
usage of this software product, you agree to the terms of this agreement. If you do not agree to the
terms of this agreement, you are not allowed to use or copy this software product. Further you are
engaged to remove the software product from your computer.

B. COPYRIGHT

The software is protected by copyright laws of United States and international copyright treaties.
Copyright and property right of the software product are set to the authors of the software. You do not
purchase any rights on the software except those called in this license agreement. You agree that all
copies of this software include the same hints about property and copyright like on and in this
software.

C. WARRANTY

The author of this software product has verified the software as best as possible to make sure the main
achievements as described work while normal usage on compatible equipment. Regarding to the
complexity of computer software we cannot guarantee that the software or documents does not
contain errors or works without intermissions on any equipment and software configuration or that it
can fulfill any other of your needs. So the software and the documentation are distributed in the state
as present and you accept all risks with the usage. The author does not take any warranty either
express or implied to the software or the documentation about its fitness generally or its qualification
for special purposes except those warranties that have to be applied through obliged laws and that
cannot be excluded. You know that you have to regularly backup your data and that you have to affect
additional security provisions if a software error is supposed.

D. SOFTWARE END-USER LICENSE AGREEMENT

PART 1

Licensee acknowledges that this is only a limited nonexclusive license. Licensor is and remains the
owner of all titles, rights, and interests in the software.

PART 2

This License permits Licensee to install the Software on more than one computer system, as long as the
software will not be used on more than one computer system simultaneously. Licensee will not make
copies of the software or allow copies of the Software to be made by others, unless authorized by this



agreement or in writing by the Licensor. Licensee may make one (1) copy of the Software for backup
purposes only.

PART 3

This Software is subject to a limited warranty. Licensor warrants to Licensee that the physical medium
on which this Software is distributed is free from defects in materials and workmanship under normal
use, the Software will perform according to its printed documentation, and to the best of Licensor’s
knowledge Licensee’s use of this Software according to the printed documentation is not an
infringement of any third party’s intellectual property rights. This limited warranty lasts for a period of
90 days after delivery.

To the extent permitted by law, THE ABOVE-STATED LIMITED WARRANTY REPLACES ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, AND LICENSOR DISCLAIMS ALL IMPLIED WARRANTIES INCLUDING ANY
IMPLIED WARRANTY OF TITLE, MERCHANTABILITY, NONINFRINGEMENT, OR OF FITNESS FOR A
PARTICULAR PURPOSE.

No agent of Licensor is authorized to make any other warranties or to modify this limited warranty. Any
action for breach of this limited warranty must be commenced within one year of the expiration of the
warranty. Because some jurisdictions do not allow any limit on the length of an implied warranty, the
above limitation may not apply to this Licensee. If the law does not allow disclaimer of implied
warranties, then any implied warranty is limited to 90 days after delivery of the Software to Licensee.
Licensee has specific legal rights pursuant to this warranty and, depending on Licensee’s jurisdiction,
may have additional rights.

PART 4

In case of a breach of the Limited Warranty, Licensee’s exclusive remedy is as follows: Licensee will
return all copies of the Software to Licensor, at Licensee’s cost, along with proof of purchase.
(Licensee can obtain a step-by-step explanation of this procedure, including a return authorization
code, by contacting Licensor on the web at www.PssAthletics.com, At Licensor’s option, Licensor will
either send Licensee a replacement copy of the Software, at Licensor’s expense, or issue a full refund.

PART 5

Notwithstanding the foregoing, LICENSOR IS NOT LIABLE TO LICENSEE FOR ANY DAMAGES, INCLUDING
COMPENSATORY, SPECIAL, INCIDENTAL, EXEMPLARY, PUNITIVE, OR CONSEQUENTIAL DAMAGES,
CONNECTED WITH OR RESULTING FROM THIS LICENSE AGREEMENT OR LICENSEE’S USE OF THIS
SOFTWARE. Licensee’s jurisdiction may not allow such a limitation of damages, so this limitation may
not apply.

PART 6

Licensee agrees to defend and indemnify Licensor and hold Licensor harmless from all claims, losses,
damages, complaints, or expenses connected with or resulting from Licensee’s business operations.

PART 7

Licensor has the right to terminate this License Agreement and Licensee’s right to use this Software
upon any material breach by Licensee.

PART 8



Licensee agrees to return to Licensor or to destroy all copies of the Software upon termination of the
License.

PART 9

This License Agreement is the entire and exclusive agreement between Licensor and Licensee regarding
this Software. This License Agreement replaces and supersedes all prior negotiations, dealings, and
agreements between Licensor and Licensee regarding this Software.

PART 10
This License Agreement is governed by the law of lowa applicable to lowa contracts.
PART 11
This License Agreement is valid without Licensor’s signature. It becomes effective upon the earlier of

Licensee’s signature or Licensee’s use of the Software.

E. ADDITIONAL LICENSE CONSIDERATIONS

The following serves as a limited record of permitted and prohibited uses. This list is subject to
change without notification and does not serve as a comprehensive agreement to permitted and
prohibited uses.

PERMITTED USES

You may use the images to create documentation of training programs/handouts/etc that will be
printed off, or digitally distributed within a .pdf document.

PROHIBITED USES

You many not use the images to create software or any other media that will allow a third party to use
the images without first licensing them. You may not display the images as is, modified, or within any
none secure document on your website or any other 3rd party media.

For additional Licensing information, please contact Progressive Sporting Systems Inc via our support
desk: http://completesupportsolutions.com/pssathletics
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How to Use the Excel Template Wizard

The Template Wizard comes with 18 formatted workout templates and one blank
workout template. Each template has a different set-up designed for multiple
applications.

How to Use the Formatted Workout Templates

Create a New Workout Wizard Workbook

1. Chose which template(s) you wish to use. Open the first template up so it
is editable. Hold down the Ctrl key and left click to highlight the other
template tabs you wish to use if there is more than one.

2. Right click on one of the highlighted template tabs and choose the Move

or Copy... option from the list.

Click Create A Copy to place a check mark in the box.

Click the down arrow for the Move Selected Sheets To Book: and

choose either (new book) or another open workbook. You should never

edit or remove a template while in the master Workout Wizard file.

5. The pages should now be copied to another workbook where you can edit
them. You should now save the new workbook before you go any further.

W

Editing the Templates

Template Headers
Each template can be customized with your business or school information.

Business Name Line 1
Put Your Logo Here BUSINESS Name Line 2

Workout Name

Clients Name

1. Enter A Logo: Chose the Insert->Picture->From File... from the top of
the page. Find you logo image and chose it. Delete the “Put Your Logo
Here” comment. Resize and move your logo to fit into the “Put Your Logo
Here” area.

2. Business Name: There are two lines for your business name. Typically
line one uses a slightly larger font than line 2 but is up to you. If you only
need one line chose whichever you like and delete the other.

3. Workout Name: This is the descriptor for your workout. This may be
something like Football: Quarterback-Phase 1, or Warm-Up 1.

4. If you are not using the Coefficient Wizard, place the clients name to the
right of the Clients Name title. If you are using the Coefficient Wizard, fill

Workout Wizard
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the name in on the Coefficient Wizard and it filter to the rest of the active
pages.

5. If you have more than one page, you can enter page numbers to the right
of the page number title. For instance, Page: 1, or Page: WU1,1.

6. The Pictures: You can delete or change the current pictures at the top of
the page at you discrepancy.

7. To Remove the Header Altogether: First delete the three pictures. Than,
left click and hold on the Excel Row Number 1 on the far most left side of
the screen. You should see row one highlighted. Drag down until you
have highlighted the first five rows. Note: If you are on the row number
the curser will turn into an arrow that points to the right. It is when you
have this arrow that you can highlight more than one row. If you see a
plus sign looking curser with up and down arrows, you will change the row
height rather than select more rows.

a. Once you have highlighted the rows right click one of the row
numbers and chose Delete from the list to delete the rows.

8. Depending on the template, your workout may be more than one page. If
this is the case:

a. Right click on one of the highlighted template tabs and choose the
Move or Copy... option from the list.

b. Click Create A Copy to place a check mark in the box.

i. You should see the name of this workbook in the Move

Selected Sheets To Book: area. Click the OK button.

c. Repeat this process for each page need. Note: be sure to do this
before you start filling out the workout area. Don’t forget to change the
page numbers at the top of the page.

The Workout Area

Each template has a different type of workout area configuration. You should
spend some time looking though the different templates to get familiarized with
the different set ups.

Ex. Name Week Set 1 Set 2 Set 3 Set 4 Set 5 Set 6 Set 7
Week 1

Week 2
Week 3
Week 4
Week 5
Image Week 6

Instructions

1. Exercise (Ex.) Name: Left Click the Ex. Name label and type the name of
your exercise.

2. This particular template is set up to provide a six-week cycle for this
specific workout. The Week # label can be changed to a date, different

Workout Wizard
www. TrainerClipart.com
Copyright 2010 www.PssAthletics.Com




week #, or other descriptor if needed. Fill in your set and rep information
for each week and desired.

3. Insert your StrenCon 3.0 image. Chose Insert->Picture->From File... at
the top of the page. Browse to the StrenCon 3.0 folders and select your
illustration. Resize the illustration to fit into the Image square. Some
images may appear a little blurred on your screen when the size is
significantly reduced. These images should print crisp and clear.

4. Instructions: Insert any wordage you chose into the instructions area.
You may have to change the font size to get large instructions into the
area.

Below is an example of a partially completed exercise block.

Week 1] 90 x6 |110 x4 ]135 x3 |135 x3 |135 x3 [135 x3
Week 2| 90 x5 |115 x3 [145 x3 |145 x3 |145 x3 |145 x3
Week 3| 90 x4 |115 x3 [135 x2 [155 x2 |155 x2 |155 x2 |155 x2
Week 4
Week 5
Week 6
Instructions: Rest for 2-3 minutes on your heavy sets.

Not all templates include the same information.

Using the Blank Template

The blank template only includes the header information. It is set up so you can
copy and paste exercise blocks (See the Power Clean Exercise Block example
above) from different Workout Wizard Templates. To create new templates do
the following:

Make a Copy of the Original Blank Template
1. Right click on Blank Template tab and choose the Move or Copy... option
from the list.
2. Click Create A Copy to place a check mark in the box.
3. You should see the name of this workbook in the Move Selected Sheets
To Book: area. Click the OK button.
4. Repeat this process for each new template you want to create.

Copy and Paste the Exercise Blocks into the Blank Template Copy
1. To highlight the exercise block left click on the uppermost left cell in the
block. Hold down the mouse button and drag over the block until it is
highlighted. Right click within the highlighted area and select copy from
the dropdown list.
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2. Go to the Blank Template copy and right click on the cell that will contain
the upper most left cell of the pasted block. Select paste from the
dropdown list to paste the copy exercise block

3. At this time save your work and then print preview the page. When you
close out of the print preview, you should see the print boundaries for the
page. You will want to stay within these boundaries when you are pasting
exercise blocks onto the page. If you go slightly out of the boundaries you
can adjust the print area by doing the following:

a. At the top of the page chose View->Page Break Preview.

b. You should see your template with Dark blue solid lines outlining
what your printer will print on each page. You can left click and
drag these blue lines to the boarder of your template to adjust the
print space for each page.

c. Print preview the pages again to double check your print area.

d. Chose View->Normal View return to the normal Excel work view.

4. If you are going to extend out of the normal bounds of the print area by
more than 2-3 cells, create another blank template copy and continue your
workout template on it.

Printing the Workouts

Make sure to print preview your workouts before you print them just in case the
page size in incorrect. If your preview shows that the page is to big to fit, do the
following:

1. At the top of the page chose View—>Page Break Preview.

2. You should see your template with Dark blue solid lines outlining what
your printer will print on each page. You can left click and drag these blue
lines to the boarder of your template to adjust the print space for each
page.

3. Print preview the pages again to double check your print area.

4. Chose View->Normal View return to the normal Excel work view.

Save Your Sanity. Don’t forget to periodically save your work.
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How to Use the Coefficient Wizard

You can use the coefficient wizard to create dynamic workout templates with
excel. These dynamic workout templates will automatically recalculated training
loads when you change the max values in the chart.

Move a Copy of the Coefficient Wizard

1. In the Workout Template Wizard, right click on the Coefficient Wizard tab
and choose the Move or Copy... option from the list.

2. Click Create A Copy to place a check mark in the box.

3. Click the down arrow for the Move Selected Sheets To Book: and
choose either (new book) if you are starting a new project, or another
open workbook. You should never edit or remove the Coefficient
Wizard while in the Excel Template Wizard.

4. The Coefficient Wizard should now be copied to another workbook where
you can work with it. You should now save the updated workbook before
you go any further.

Input the Exercise Name and Max Variables

The Coefficient Wizard allows you to utilize 19 different max effort lifts per
workbook. You can only import one Coefficient Wizard per workbook. If you
need to utilize more than 19 max efforts, set up two or more workbooks.

Oe e dl O
Athlete Name: i)Y
2

P E g o b o 5 8 .g

S| 8| &6 || 3|2 |5|3|¢8|:%

& a 3 2 2 | & 3 £ 5 2 2

s 2 Dire Belo Do ed e

100 | 150 | 200 | 234 | 324 | 134 | 134 | 543 | 231 | 443 | 333

0% 5 10 10 10 15 5 5 25 10 20 15
o 10 10 15 20 25 10 10 40 15 35 25
0.0% RN 15 20 25 30 15 15 55 25 45 35
15 20 25 30 40 15 15 70 30 55 40

Enter Your Exercise Names
Enter the athlete/clients name into the grey Coefficient Wizard name box. You
can enter up to 19 different exercises into the Coefficient Wizard (although you
can use an unlimited amount of exercises in the workout templates). Your
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exercise names go into the grey Exercise Name boxes directly under the
Coefficient Wizard title.

Enter Your Max Values

Input your max values into the small grey boxes directly under their given names.
Once you enter the number into the grey box the percentages will automatically
be calculated directly under the max number. Fill in all of the numbers you
desire. If you leave a max value blank (or input a letter) you will see #### in the
percentage boxes below. This is fine, leave the unused boxes blank so they do
not show up in your max values report (see Max Values Report).

Using the Calculated Percentages in the Templates

You can copy and paste the percentages from the Coefficient Wizard into any of
the Workout Wizard Templates within the workbook that houses that Coefficient
Wizard (a workbook is made up of all the worksheets within a given Excel file).
You cannot copy and paste from a Coefficient Wizard in another workbook.

To Copy and Paste do the following:

1. Left click and hold on the first Workout Wizard Templates tab (worksheet
tab) you plan to use. Drag the tab to beside the Coefficient Wizard.

2. Go back to the Coefficient Wizard, right click, and copy the first
percentage you want to use in the workout template. Remember that the
percentages are specific to a particular exercise, so make sure you are
using the correct column of percentages. Return to the Workout Wizard
Template, right click the destination cell and paste the value.

100 150 200 | 234

5 10 10 10
10

10 Copy 25
15 30

15 25 30 35

3. Repeat this step for each percentage for each exercise you wish to have
automatically calculated.

4. When you change the Max Values in the Coefficient Wizard, the Workout
Wizard will automatically recalculate the percentages in the Workout
Wizard Templates. Note, if you do not want to use the values from the
Coefficient Wizard you can simply type them in the workout templates. If
you just want the template to display a true percentage (i.e. 10 for 10%, or
95 for 95%) change the max value for that exercise to 100 in the
Coefficient Wizard.
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The Max Values Report

The max values you enter into the Coefficient Wizard are filtered into a Max
Values Report for you to print, or copy and paste to a master file. The report is
dynamic in the sense that will automatically display exercises and max value
cells from the Coefficient Wizard that contain information.

If you leave cells blank, they will appear as blank unformatted cells in the report.
For aesthetics, keep all of your active cells in the Coefficient Wizard in adjacent
columns to avoid having blanks cells in the middle of the report. All information
in the Max Values Report except for the date is dynamically generated by the
Workout Wizard. You can manually fill the date in immediately to the right of the
date label on the report if you desire.

Exercise Name Max Value

Squats 400
Deadlift 355
lunge 50
push up 65
pull up 22
situp 65
bench press 315
incline press 285
shoulder press 65
front raise 45
pull through 105
incline row 85
lateral raise 350
step up 45
hang clean 215
snhatch 175
zercher 365
1 leg RdlI 85
hyper 60
Workout Wizard
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The Estimated Max Wizard
You can use the Estimated Max Wizard to calculate a one repetition max from a

repetition max. Enter the weight used in the square to the right of the Load:
label. Enter the number or reps into the cell directly to the right of the Reps:
label. The estimated max will appear to the right of the Estimated Max: label.

Estimated Max Wizard

Load:
Reps:

Estimated Max:m

Note: For the Coefficient Wizard to calculate the percentages you must have the
Analysis ToolPak — VBA Add In check marked. To do this simply select
Tools>Add Ins...2>Analysis ToolPak — VBA (should have a check mark

beside it).




Lift Calc Sheets

The Lift Calc Sheets can be used to create lifting charts of calculate true training loads for a lift
based off of the max of another lift. For example, you may want to calculate training weights for
an RDL based off of a squat max. More specifically, as you will see in the examples below, you
may want to indicate how much weight your athletes should use on their RDL’s for 4 sets of 6
based off of their squat max.

1) Enter the name of the exercise in the area labeled Lift No. ?. There is room for 3
exercises on this form.
2) Change the number of sets or reps if needed.

—
RD

=

Lift Ho. 2 Lift Ho. 3

Max Loads W Max Loads
3 200| 25 x6 420 50 x5
205 | 110 =6 425 | 225wk 25| 35 x6 425 | [0 =6 205 | J5xb | 425 50 =6
20| 110 =6 430 | 225 xB HO| 35 xB 430 [ T x5 210 | 25 x6 | |430| 50 =6
215 [ 115 %6 435 | 230 %6 Z15| 35 %6 435 | 70 x6 215| 25%6 | [435] 5
20| 110 =h 440 | 2700 =6 20| 35 xh 440 | 70 «h 20| 2hxh | (44D 55
225 | 120 x6 445 | 235 6 235| 35 %6 45| 70 x6 225 | 25 %6 45| 55
| 230 | 120 xb L4090 | 235 xb 230 35 x5 450 | /0 xb 250 | 30 xb 450 5
235 125 »6 455 | 240 =6 235| 40 xB 455 75 x5 235| 30 x6 | |455] 55
240 | 125 %6 460 | 240 xE 240 | 40 x5 460 | 75 x6 240 306 | [460] 5
245 130 =h A65 | 245 x6 45| 40 <G 465 | 7ho«h 25| 70«6 | |465] &5
250 | 130 x6 ATO | 215 x6 | 230 | 10 %6 470 | 75 x6 250 | 30 x6 AT0 | 55 x
255 | 135 xb A5 | 250 xb 235 | 40 x5 45| [5%6 255 | 306 | |45 %
260 135 x6 480 | 250 x6 260 | 40 x5 480 [ T5 x6 260 | 30 x5 | | 480
2635 | 140 x6 485 | 255 wb 265 | 40 x6 4B5 | 20 x6 265 | 30 x6 | | 485
270 | 140 =h 490 | 255 x6 270 | 45 <6 490 | 80 <6 20| 30«6 | | 450
275 | 145 x6 495 | 260 6 275| 15 x5 495 | 80 x6 275 | 35 x6 183
280 | 145 =6 S0 | 255 =B 280 | 45 x5 500 | B0 x5 280 | 35 xb 500
_

200 | 105 x6 A20 | 220 «6

3) The “Modifier” value determines what percentage of the maxed lift would equal 100
percent of the calculated lifts max. For instance you may conclude that a RDL 1 rep
max would equate closely to 75% of a squat 1 rep max. So you would set the Modifier
to .75.

4) The “Intensity” value correlates to the percentage of 1 rep max of the new calculated
value you wish to use. For example you may wish to train at 70 percent of the RDL 1
rep max. So, you would set the Intensity to .7.

390 | 60 xb
395 | 65 x6 615|100 =6 395| 45 x6 | [615| 75 xB
| 620 | | 400 | 65 x6 620|100 x6| |400) 50 6 | | 620 |
AN5 | M5 <6 75 |0 405 | 65 xh 625 | 100 405| 50 w6 | [ 625
A10] 215 %6 630 | 330 x5 410 | 65 x6 630 | 100 %6 A10] 50 x5 | [630
415 | 220 x6 B3 [ddb x6]| [415) Ghxb B35 | 100 6 415] S0 x| [ B35

Modher - 0./5 Modiher - U.4 Modmher - 0.4

ntensiy- 0.7 Infensty- 0.4 Iniensiy- 0.]

395 | 205 =6 615
400 | 210 x6 620 | 32

As you can see in the example in picture one above, an athlete with a 200 Ib squat max would
then be prescribed 105Ibs for their 4 sets of 6 on RDL's.
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A_bbreviations
PB= PHYSIOBALL
DB= DUMBBELL
F= FAILURE
E= EACH
BK= BELOW THE KNEE





